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Qualified Persons
Ç WARNING

The equipment covered by this publication must be installed, operated, and maintained by 
qualified persons who are knowledgeable in the installation, operation, and maintenance 
of overhead electric power distribution equipment along with the associated hazards. 
A qualified person is one who is trained and competent in:

•   The skills and techniques necessary to distinguish exposed live parts from non-
live parts of electrical equipment.

•   The skills and techniques necessary to determine the proper approach distances 
corresponding to the voltages to which the qualifi ed person will be exposed.

•   The proper use of the special  precautionary  techniques,  personal  protective 
equipment, insulating and shielding materials, and insulated tools for working on 
or near exposed energized parts of electrical equipment.
These instructions are intended only for such qualified persons. They are not 

intended to be a substitute for adequate training and experience in safety procedures 
for this type of equipment.

Read this Instruction 
Sheet

Thoroughly and carefully read this instruction sheet before programming, operating, or 
maintaining your S&C Universal Interface Module. Familiarize yourself with the safety 
information on page 3. The latest version of this instruction sheet is available online in 
PDF format at www.sandc.com. Select: Support/Product Literature Library.

Retain this Instruction 
Sheet

Designate a location where you can easily retrieve and refer to this instruction sheet. 

Warranty The standard warranty contained in S&C’s standard conditions of sale, as set forth in 
Price Sheet 150, applies to the Universal Interface Module, except that the first paragraph 
of said warranty is replaced by the following:

(1) General: Seller warrants to immediate purchaser or end user for a period of 10 
years from the date of shipment that the equipment delivered will be of the kind and 
quality specified in the contract description and will be free of defects of workmanship 
and material. Should any failure to conform to this warranty appear under proper and 
normal use within ten years after the date of shipment the seller agrees, upon prompt 
notification thereof and confirmation that the equipment has been stored, installed, oper-
ated, inspected, and maintained in accordance with recommendations of the seller and 
standard industry practice, to correct the nonconformity either by repairing any dam-
aged or defective parts of the equipment or (at seller’s option) by shipment of necessary 
replacement parts. The seller’s warranty does not apply to any equipment that has been 
disassembled, repaired, or altered by anyone other than the seller. This limited warranty 
is granted only to the immediate purchaser or, if the equipment is purchased by a third 
party for installation in third-party equipment, the end user of the equipment. The seller’s 
duty to perform under any warranty may be delayed, at the seller’s sole option, until the 
seller has been paid in full for all goods purchased by the immediate purchaser. No such 
delay shall extend the warranty period.

Replacement parts provided by seller or repairs performed by seller under the war-
ranty for the original equipment will be covered by the above special warranty provision 
for its duration. Replacement parts purchased separately will be covered by the above 
special warranty provision.

Warranty of the Universal Interface Module is contingent upon the installation, configu-
ration, and use of the control or software in accordance with S&C’s applicable instruction 
sheets. This warranty does not apply to major components not of S&C manufacture, such 
as batteries, and communication devices. However, S&C will assign to immediate pur-
chaser or end user all manufacturer’s warranties that apply to such major components.

Introduction
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Understanding
Safety-Alert Messages

There are several types of safety-alert messages which may appear throughout this 
instruction sheet as well as on labels attached to the Universal Interface Module. 
Familiarize yourself with these types of messages and the importance of the various 
signal words, as explained below.

Ç DANGER
“DANGER” identifies the most serious and immediate hazards which will likely 
result in serious personal injury or death if instructions, including recommended 
precautions, are not followed.

Ç WARNING
“WARNING” identifies hazards or unsafe practices which can result in serious 
personal injury or death if instructions, including recommended precautions, are 
not followed.

Ç CAUTION
“CAUTION” identifies hazards or unsafe practices which can result in minor per-
sonal injury or product or property damage if instructions, including recommended 
precautions, are not followed.

NOTICE
“NOTICE” identifies important procedures or requirements that can result in product 
or property damage if instructions are not followed.

Following
Safety Instructions

If you do not understand any portion of this instruction sheet and need assistance, 
contact your nearest S&C Sales Office or S&C Authorized Distributor. Their tele-
phone numbers are listed on S&C’s website www.sandc.com. Or call S&C Headquarters 
at (773) 338-1000; in Canada, call S&C Electric Canada Ltd. at (416) 249-9171.

NOTICE

Read this instruction sheet thoroughly and carefully 
before installing or operating your S&C Universal 
Interface Module.

Replacement 
Instructions and Labels

If you need additional copies of this instruction sheet, contact your nearest S&C Sales 
Office, S&C Authorized Distributor, S&C Headquarters, or S&C Electric Canada Ltd.

It is important that any missing, damaged, or faded labels on the equipment be replaced 
immediately. Replacement labels are available by contacting your nearest S&C Sales 
Office, S&C Authorized Distributor, S&C Headquarters, or S&C Electric Canada Ltd.

Safety Information



4  S&C Instruction Sheet 1043-530 

Ç WARNING
These instructions do NOT replace the need for utility operation standards. Any 
conflict between the information in this document and utility practices should be 
reviewed by appropriate utility personnel and a decision made as to the correct 
procedures to follow.

 Serious risk of personal injury or death may result from contact with electric 
distribution equipment when electrical isolation and grounding procedures are not 
followed. The equipment described in this document must be operated and main-
tained by qualified persons who are thoroughly trained and understand any hazards 
that may be involved. This document is written only for such qualified persons and 
is not a substitute for adequate training and experience in safety procedures for 
accessing high voltage equipment.

 The Universal Interface Module and host control are connected to switchgear 
operating at primary voltage levels. High voltage may be present in the wiring to the 
switch control or the switch control itself during certain failures of the switchgear 
wiring or grounding system, or due to a failure of the switch itself. For this reason, 
access to the switch control should be treated with the same safety precautions 
that would be applied when accessing other high voltage lines and equipment. Fol-
low all locally-approved safety procedures when working on or around this switch 
control.

 Before attempting to access an existing switch installation, check carefully for 
visible or audible signs of electrical or physical malfunction (do this before touching 
or operating the switch control or any other part of the installation). These warning 
signs include such things as smoke, fire, open fuses, crackling noises, loud buzzing, 
etc. If a malfunction is suspected, treat all components of the installation, including 
the switch control and associated mounting hardware, as if they were elevated to 
primary (high) voltage.

 Whenever you are manually reconfiguring the circuit (for example, during repairs), 
follow your company’s operating procedures to disable automatic operation of the 
IntelliTEAM system. This prevents any unexpected operation of a team member. 

 You can disable the IntelliTEAM system by pressing the automatic operation 
ENABLE/DISABLE faceplate button to DISABLE on the faceplate of any active 
5800 based team member of the team you want to disable, or turn on PROHIBIT 

RESTORATION on the faceplate of the UIM.

Applicable Software These instructions were prepared for use with software UIMD3C1X, Rev. 1.5. References 
in this manual to IntelliTEAM apply for IntelliTEAM II or later revisions.

 You can find the revision number on the Setup disk label, and on the main screen of the 
UIM, called the PRESENT CONDITIONS screen. For questions regarding the applicability 
of information in this chapter to future software releases, please contact S&C.

IntelliTEAM System
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Planning Your 
IntelliTEAM System

The IntelliTEAM system lets teams of controls work together to isolate faults and restore 
service. Whether your team consists of a few switches on a single feeder or a complex 
configuration with multiple alternate sources, we recommend mapping out the team(s) 
and gathering all necessary information before installing hardware in the field. We also 
recommend keeping a copy of this information in the door of the switch control enclosure 
or low voltage cabinet.

 During planning and setup of fault detection settings, be sure to consider the fault condi-
tions that the IntelliTEAM system may encounter from alternate sources.

1.      Create a layout of the source(s), switches, and line segments that will include 
teams.

You can use a system map or similar diagram showing source and switch locations.

2.     Plan your communications system.

For more information, see the manufacturer’s documentation for your communica-
tions system.

3.     Identify and name the team(s).

Form teams by including all automated switches that border each line segment. 
Choose a team name up to 16 characters. Also, assign team designations (“Team 
1” to “Team 8,” as needed) for the SETUP: Team screens. Teams that share a team 
member must have different designations. 

4.     Assign each team member a DNP/RTU address.

Each team member requires a unique DNP/RTU address. You will enter this informa-
tion on the SETUP: Team screen.

5.     Determine the switch/position number for each team member.

Each team member is associated with a switch/position number (for example, “Sw1” 
for a single overhead switch). Enter this information on the SETUP: Team screen.

6.     Note the normally open/closed state for each team member.

Enter this information on the SETUP: Team screen.

IntelliTEAM System
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7.     Determine the normal functionality for each team member.

There are six types of functionality for team members:

Functionality Description

Closed Switches

Source/Sub Use this value when the normally closed source switch is 
the first team member after the source/substation, or is an 
Interface Module on the source breaker relay.

Source Use this value for one closed switch in the team through 
which the line segment receives power when the circuit is 
in its normal configuration.

Load/Tie A team may have zero, one, or multiple closed switches 
through which loads on other line segments receive power. 
Use this value when the switch, when reclosed, could be 
used to restore power to the line segment indirectly from 
an alternate source.

Load A team may have zero, one, or multiple closed switches 
through which loads on other line segments receive power. 
Use this value when the switch would not be involved when 
restoring power to the line segment because the other line 
segments have no alternate sources.

IMPORTANT: Every CLOSED switch should have its sen-
sors facing the normal source of the team.

Open Switches

Tie/Sub Use this value when the tie switch is the first team member 
after the substation/source.

IMPORTANT: A Tie/Sub switch should have its voltage 
sensors facing the alternate source.

Tie Use this value for zero, one, or multiple open switches in the 
team that restore power to the line segment directly from 
an alternate source when closed.

Enter this information on the SETUP: Team screen.

8.     Determine the Return to Normal mode for each team.

If desired, the team members can return the circuit to its normal configuration 
automatically once a stable 3-phase voltage has been restored to the faulted line seg-
ment. For teams with one or more tie switches, you can choose open transition (the 
tie switch(es) open before the other team members return the circuit to its normal 
configuration) or closed transition (the team members close all of the switches and 
then the tie switch(es) open). The Return to Normal process starts at the line seg-
ments closest to the normal source, and works outward.

 A single team member should have the same Return to Normal mode for each 
team where it is a member; however, a team may end up with members with differ-
ent modes.

 You will enter this information on the SETUP: Team screen.

IntelliTEAM System
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9.     Determine the value for the “RTN Time” setpoint.

Power must be restored to the faulted line segment for this amount of time (in min-
utes) before the Return to Normal process will start. Enter this information on the 
SETUP: Team screen.

10.   Determine the Maximum Capacity for each team member.

The maximum capacity is the amount of load on the most limited line section 
(because of conductor size, switch rating, etc.) served through a team member’s 
location from either direction. Each member continuously subtracts its present 
load from its Maximum Capacity to determine its Local Capacity for Transfer. The 
smallest Local Capacity for Transfer encountered in a particular restoration path 
determines the maximum load that the involved teams can transfer, the Available 
Capacity to Transfer.

 Enter this information in the “Maximum Capacity” setpoint on the SETUP: Team 

screen. 

11.   Determine the alternate source sequence for each team.

Using the normal switch functionalities found for Step 7, set the sequence in which 
team members will be used to restore the line segment. If the team cannot use the 
source switch to restore the line segment, then the team tries the members listed 
here. You will enter this information in the “Alternate Source Sequence” setpoints 
on the SETUP: Team screen.

 IMPORTANT: These setpoints are optional. If you do not enter values for these 
setpoints, or if the selected team members cannot be used to restore the line seg-
ment, then the team tries the tie switch(es) to find an alternate source. If this is not 
successful, the team then tries the load/tie switch(es).

12.   Determine whether any “contracts” are required to avoid overloading a line 
segment.

If a line segment cannot handle any overloading at all, or if the possibility of over-
loading is high, you will need to set the “Contract Required” setpoint to “Yes,” on the 
SETUP: Team screen.

 You may specify any line segment as requiring a contract. Once team members 
encounter a line segment in a restoration path that requires a contract, they will com-
municate with all subsequent line segments in the direction of the alternate source 
to insure that the alternate source will not be overloaded. Note that this also slows 
down the reconfiguration process.

13.   Determine whether you need to limit the number of line segments restored 
by a team.

 If you want to limit the number of line segments that a team picks up, you will 
need to enable the “Line Segment Limit” setpoint (on the SETUP: Team screen). For 
example, “Add 1” inhibits any other line segments from being restored through a 
member after it restores its first line segment. 

 To allow the team to pick up as many line segments as capacity allows, set this 
value to “N/A.”

IntelliTEAM System



8  S&C Instruction Sheet 1043-530 

IntelliLINK Software

Install IntelliLINK

This section provides an introduction to the IntelliLINK software and how to install and 
use it on your computer.

 You will need the following items to install the software, set up the control, set up the 
communications equipment (radio, modem, etc.), and enable team operation. You can 
also use these items to diagnose certain types of hardware problems that can occur dur-
ing installation.

• Portable IBM/PC-compatible Computer – The computer must be transportable to the 
switch control installation site and must include:

 •   Microsoft Windows 98/2000/ME/XP or Windows NT®

 •   A serial communications port

 •   A CD ROM disk drive, or access to the S&C Automation Information Center (www.
energyline.com/support.htm).

• RS232 Serial Cable – This cable must have a DB9 pin connector at one end (to plug 
into the local access port on the switch control faceplate) and a connector at the 
other end which fits the serial port on the computer. The cable should be long enough 
to reach comfortably from the switch control to your computer after the control is 
installed at the site. It must be a “straight-through” cable, not a null-modem cable.

• Setup CD – A setup CD is supplied with the Interface Module. You will use this soft-
ware to set up the Interface Module and the team. The same software is used for 
troubleshooting.

• IMPORTANT:   S&C ships several types of software-controlled products. Make sure 

you have the correct CD for the interface Module. The latest versions are posted 
at www.sandc.com – select:  Support>S&C Automation Information Center. If you 
don’t have a password, please contact:

 infocenter@sandc.com

To install the IntelliLINK software: 

•     Insert the Universal Interface Module CD into your CD ROM drive.

•     On the Windows Start menu, click Run. 

•     The Run dialog box appears.

•     Type the letter of the drive in which you put the disk, followed by SETUP (for 
example, E:\SETUP), then click OK.

•     The Installer will guide you through the software installation process.

•     When installation is complete, you can shut down your computer or go directly to 
the Start IntelliLINK Software section, and begin configuration.

Start IntelliLINK The steps below explain how to start the IntelliLINK software when you want to work 
with the setpoints or stored data in the Universal Interface Module. If you want to edit 
a snapshot (virtual memory file) or simply view the software without data, see Using 

Snapshots in S&C Instruction Sheet 1043-540.

IntelliLINK Software
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NOTICE
If you use a 2-wire, ungrounded extension cord to power either your computer OR 
the /Interface Module and IED while they are connected, you may damage the serial 
port on your computer. ALWAYS use grounded, 3-wire extension cords, or computer 
battery power.

1.     Connect your computer to the Universal Interface Module.

Plug one end of the communications cable into the serial port on your computer, 
then plug the other end into the LOCAL COMM. PORT on the Interface Module 
faceplate.

2.     Open your IntelliLINK program.

To run your IntelliLINK program:  click Start>Programs>EnergyLine>IntelliLINK.

3.     Wait while the IntelliLINK software attempts to open communications with 
the Universal Interface Module.

When the IntelliLINK software establishes communications with the Universal 
Interface Module, the PRESENT CONDITIONS screen (Figure 1) opens. You can 
now set up the software in the Universal Interface Module, view and save the 
“live” data that is in the module, load settings into the module, and perform main-
tenance and troubleshooting.

IntelliLINK Menu
Navigation Buttons

 The Tree button, at the right of the Main button, opens the Select Screen dialog box, 
and presents an expandable tree view of the UIM Screenset, similar to Windows Explorer. 
Double click on the screen name that you want to go to.

Navigating the 
IntelliLINK Screens

The Main button, at the bottom of each screen, takes you back to the Present Conditions 
screen, which is the main screen for UIM IntelliLINK Software. From this screen you can 
get to all other screens. You can also return to the Present Conditions screen, by opening 
the Window menu, and selecting Show Main Screen.

IntelliLINK Software
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Figure 1. PRESENT CONDITIONS screen for the Universal Interface Module.

 NOTE: If IntelliLINK software does NOT establish communication with a functioning 
Universal Interface Module, it displays the message: “Could not connect to control on 
COM I.” in the Connect dialog box.

View the Present Conditions Screen

The PRESENT CONDITIONS screen (Figure 1) shows the present status of various switch 
control settings, any existing fault and error conditions.

To display the PRESENT CONDITIONS screen:

Click the Main button at the bottom of any IntelliLINK screen to go to the Present Condi-

tions screen.

 If this message appears, or if the PRESENT CONDITIONS screen opens but the soft-
ware does not operate properly, see Software Troubleshooting in S&C Instruction Sheet 

1043-550. 

IntelliLINK Software
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The IntelliLINK software includes a series of screens and dialog boxes which enable you 
to set up the Universal Interface Module, and then view and manage team activity.

 To open a menu screen (for example, the COMM MENU or TEAM MENU), click the 
Main button, found at the bottom of every screen, and this will take you to the PRESENT 

CONDITIONS screen where you can find this set of selection buttons.

To Change Data Values on IntelliLINK Screens
To add or change a value on a setup screen (for example, the SETUP: Miscellaneous 
screen shown in Figure 3):

• Move the mouse cursor onto the value you want to change. When the cursor changes 
to a double-arrow, click the left mouse button to open a Change Value dialog box, 
double-arrow cursor:

• If the dialog box accepts typed input, use the keyboard keys to enter the new 
value. If the dialog box does not accept typed input, click the Up or Down arrow 
to change the value, or click the radio button for the correct value.

• Click OK to record the new value (or click Cancel to leave the dialog box without 
changing the value).

• Repeat this process for each value you want to add or change.
• To view Help text for all the fi elds on the screen, press <F1>.

Entering Data

IntelliLINK Software
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IntelliLINK Software Menu Tree for Universal Interface Module

PRESENT CONDITIONS

DATA LOGGING
 DATA LOGGING SETUP
 HISTORIC EVENT VIEW (8 pages of Data)
 LOGGING STATUS POINTS (3 pages of Data)
 SPECIAL EVENT COUNTERS (2 pages of Data)
 SYSTEM STARTUP HISTORY

COMMUNICATION MENU
 SETUP: Communications (5 pages)
 SETUP: DNP Status Points Map (4 pages)
 SETUP: DNP Analog Points Map (7 pages)
 SETUP: DNP Counter Points Map
 SETUP: DNP Control Points Map (2 pages)
 SETUP: DNP Analog Output Points Map
 SETUP: Communications Diagnostics

TEAM MENU
 TEAM SETUP MENU
  SETUP: Team (for 8 Teams)
 OPERATION MENU 
  TEAM OPERATION MENU
   OPERATION: Team 1 to 8 (2 pages)
  MISC OPERATION
   TEAM MEMBER TASK OPERATION
   CONTRACT STATUS
   TEAM MEMBER ACTION PATH
   COACH ACTIVITY
  PROHIBIT RESTORATION
 SETUP MENU
  TEAM SETUP
   SETUP: Team (for 8 Teams)
  EXTERNAL LOADING
  MISC SETUP

EXTERNAL DEVICE MENU
 BEGIN SETUP
 SETUP: Miscellaneous
 SETUP: Automatic Operation
 SETUP: DNP Status Points Map (2 pages)
 SETUP: DNP Analog Points Map
 SETUP: DNP Control Points Map
 SETUP: Communications

Software Menu Tree

IntelliLINK Software
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Ç WARNING
These instructions do NOT replace the need for utility operation standards. Any 
conflict between the information in this document and utility practices should be 
reviewed by appropriate utility personnel and a decision made as to the correct 
procedures to follow.

Figure 2. Begin Setup screen.

Interface Module Setup When you set up the Universal Interface Module and team for normal operation, you carry 
out a series of steps which are outlined in the Suggested Team Installation/Setup Procedure 
flow charts at the end of S&C Instruction Sheet 1043-500.

 The values you enter on each setup screen depend on your electrical distribution system 
and details specific to each individual switch.

1.     Establish communication with the Universal Interface Module and start the 
IntelliLINK software.

For details, see Start IntelliLINK on page 8. If the software is already running, you 
can skip this step.

2.     Click the External Device Menu Button, and the Begin Setup Button to dis-
play the BEGIN SETUP screen. See Figure 2.

Device Data Updates

When you set this parameter to Running the Interface Module starts polling the external 
device for binary status, analog inputs and binary counters. A check is also made at the 
Running state to verify that any programmed automatic settings have associated status, 
control and analog inputs programmed, if not, Running will be set to Stopped and a Pro-
tection Config. Error will be active in Data Logging Status Points. For example, when 
extended loss of voltage is enabled in Setup Auto Op, status points for voltage present and 
analog inputs for phase voltage must be entered. When Reclose Blocking and Unblocking 
are enabled, control points and status points must be entered.

Universal Interface Module Setup
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Figure 3. SETUP: Miscellaneous screen.

3.     Click the External Device Menu Button, then the Misc Setup Button, to go to 
the SETUP: Miscellaneous screen. See Figure 3.

External Device Setup

 As a configuration check, once Running is set, any change to automatic operation, status 
points, analog inputs, control points, will put the polling state to stopped. This is done to 
prevent any unintended operation while the external device configuration is being changed. 
So the normal configuration sequence is to be in the Stopped state, go through all setup 
screens, and then when done go to the Running state.

Ç CAUTION
Before making changes to any DNP settings here, or from the Comm Setup screens, 
set the Device Data Updates to Stopped to prevent data from being used incorrectly. 
When your changes are complete, set Device Data Updates to Running to allow 
continuously retrieved data to be used again.

This screen allows you to enter miscellaneous setup information for this switch control. 
The screen includes the following fields:

Extended Polling Log Messages

When this is set to Enabled and the above setpoint is set to Running, the Data Logging: 
Historic Events log will capture the transmission and response of the communication data 
(with time stamps) to the external device. This is useful for fine tuning the communica-
tions link to the device. However the frequently logged messages will fill up the compact 
flash unnecessarily, so setting this setpoint to disabled will stop frequent messages from 
being logged.

Universal Interface Module Setup
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Universal Interface Module Setup

Daylight Savings Time Automatic Changeover

When the field is set to “Enabled,” the interface module automatically adjusts its clock for 
the start and end of daylight savings time. Check with your SCADA vendor to see if the 
SCADA master will correct for daylight savings time. If it does, leave the control change-
over disabled or the correction will be made twice.

Calendar Timeclock Time/Date

The time and date are set at the factory to Pacific Standard Time (GMT-8:00). If the Uni-
versal Interface Module is installed in a different time zone, you will need to reset these 
values. Select Tools>Set Control Clock to set the time in the Interface Module to the time 
on your computer.

Automatic Daylight Savings Schedule

Use these setpoints to configure the start and end dates for daylight savings time.

 If Daylight Savings Time Automatic Changeover (see above) is enabled, the time/date 
statement includes the current daylight savings time status, for example:

Tuesday, May 30, 2006 3:25:08 Daylight Savings

 The Universal Interface Module uses this information for data logging and event       
recording.

Physical Location 

Enter your company’s standard location identifier, for example “Switch # 429, 73 Main St., 
Centerville.” This will help identify the breaker or recloser to the SCADA master station 
operator, and appears on all reports generated from the Universal Interface Module.
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Figure 4. SETUP: Automatic Operation screen.

4.     Click the External Device Menu Button, then the Auto Op Setup Button and 
enter the correct values for the Interface Module and External Device.

Voltage trip can be initiated by the external device or interface module. This is true for 
extended three-phase and single phase voltage losses. If interface module voltage trip is 
enabled, one or both features must be selected, and the time and threshold must be set. 
If the user chooses to initiate voltage tripping using the external device, Extended Volt-
age and Single Phase Loss Protection is set to None, and the time and threshold settings 
become “N/A.” The time and threshold must then be specified in the external device. If 
the user chooses to configure the interface module to initiate voltage trips and also leave 
voltage tripping active in the external device, then the external device time threshold 
should be shorter than the interface module loss of voltage time threshold to give the 
external device logic priority.

 When the external device initiates a single or three-phase voltage trip, the interface 
module will see the action as an external operation. However, this action will be qualified 
as a valid transfer event when it is accompanied by a voltage loss. The interface module 
will look at the voltage present status points to make this decision.

 When the interface module initiates a single or three-phase voltage loss, the module 
will use the voltage analog points to make a sectionalizing decision.

 If the user selects single or three-phase or both types of extended loss protection, logic 
checks the analog inputs and binary status points to make sure that voltage status and 
analog input voltage points have been programmed/mapped to support extended voltage 
loss operation. If they have not been mapped, alarm processing will prevent the team 
from going into ready status.

Automatic Operation 
Setup

Universal Interface Module Setup
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 The SETUP: Automatic Operation screen allows you to enable and disable various 
automatic switch control operations and enter the setpoints for these operations.

Interface Module Settings 

Extended VLoss & Single Phase VLoss Enabled/Disabled

If it is desired to have the Interface Module initiate extended phase or three phase voltage 
losses, set this to enabled.

Extended VLoss & Single Phase VLoss Protection Type

Enter the desired protection type here.

Extended VLoss & Single Phase VLoss Time (sec)

Enter the amount of time in seconds to qualify a voltage or phase loss.

 When only one phase is being monitored, for the required analog and status points for 
phase voltage and phase voltage present, use the same point numbers for all phases. 

Extended VLoss & Single Phase VLoss Threshold (vac)

To qualify a voltage or phase loss, the reported analog values are converted to a 120 vac 
base and then compared to this value.

Recloser Blocked Time (sec) 

When a close operation is executed, IntelliTEAM does not register a successful close until 
the timer elapses. Only then is the reconfiguration process allowed to continue.

 The Control Point Operation Timeout located at “External Device Menu, Control Points” 
is an overall timer that IntelliTEAM uses to not wait indefinitely for control point opera-
tions to complete. To allow time for the External Device to qualify a good close operation, 
make sure the Recloser Blocked Time is always less than the “Control Point Operation 
Timeout.”

Memory Reset Time (sec)

This is the number of seconds during which IntelliTEAM remembers that a voltage loss 
and/or overcurrent event occurred, and can use this information if the event leads to a 
lockout condition of this relay/recloser device, or any source side device. Generally you 
should set this value to a time 5 seconds longer than the maximum lockout time.

Manual Operation Timeout (sec) 

Whenever the normally closed external device is reporting it is open, this timer is started 
to wait for the cause of the change of state. A manual operation alarm condition is not 
entered for the following:

 A frequency trip is indicated, the UIM has initiated an extended voltage loss trip, fault 
targets are active and the cycling status is not in the configuration, the cycling status 
becomes active, or if fault targets are active and tripped to lockout is active.

 If the Manual Operation Timeout occurs before any of the above indicators become 
active, a manual operation alarm condition is entered.

 On a normally open external device, if IntelliTEAM isn’t involved with a restoration 
close command and a closed indication is reported, the Manual Operation Timer is not 
used, and an immediate manual operation alarm condition is entered.

 If the UIM senses that the external device has tripped open with voltage loss indicators, 
this is qualified as a manual operation.

Universal Interface Module Setup
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External Device Settings 

The following settings direct the Interface Module in its operation of the host relay/recloser 
device.

Reclosing Relay 

When this parameter is set to Supported and Enabled it indicates to the Interface Module 
that the reclosing feature of the host device is enabled in its normal state, and that the 
reclosing feature is available for use by IntelliTEAM during reconfiguration events. The 
sequence of commands sent to the host device when this parameter is supported and 
enabled are:  block reclosing, send the close command and then re-enable reclosing. If 
this parameter is set to Unsupported, IntelliTEAM will not issue the reclosing block and 
reclosing enable commands during reconfiguration. When reclosing is Supported and 
Enabled and the Interface Module detects that the reclosing feature has been taken out 
of its normal state by an external means (faceplate or SCADA), the Interface Module con-
siders this to be human intervention and will cause the associated team to be not-Ready. 
It will also prevent automatic operation of the relay/recloser device by IntelliTEAM until 
the condition has been cleared. 

Ground Trip 

Ground Trip for use by Universal Interface Module/IntelliTEAM is not supported at this 
time. 

Normal Profile 

You should set this parameter to the settings profile you would like the host relay/recloser 
device to use under normal circuit conditions. When Supported and Enabled and the 
Interface Module detects that the settings profile has been changed by an external means 
(faceplate or SCADA), the Interface Module considers this to be human intervention and 
will cause the associated team to be not-Ready. It will also prevent automatic operation 
of the relay/recloser device by IntelliTEAM until the condition has been cleared. 

Alternate Profile 

You should set this parameter to the settings profile you would like the host relay/recloser 
device to use under reconfigured circuit conditions. During a reconfiguration event 
IntelliTEAM will change the active profile to this configured profile as part of the sequence 
of operating the relay/recloser device. When Supported and Enabled and the Interface 
Module detects that the settings profile has been changed by an external means (faceplate 
or SCADA), the Interface Module considers this to be human intervention and will cause 
the associated team to be not-Ready. It will also prevent automatic operation of the relay/
recloser device by IntelliTEAM until the condition has been cleared.

 NOTE:  If the profile is changed during circuit reconfiguration and automatic “Return 
to Normal” is enabled, IntelliTEAM logic does not reset the profile back as part of the 
“Return to Normal” process. However, this can be accomplished remotely with a SCADA 
control point operation.
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Figure 5. SETUP: DNP Status Points Map for the External Device.

5.     Click the External Device Menu Button, then the Status Points Button, and 
enter the correct values for External Device.

The following 2 screens allow programming of the status points used by the Universal 
Interface Module and IntelliTEAM. The minimum required points are highlighted with an 
asterisk. Additional points will need to be mapped depending upon the desired protection 
settings. 

Point Number

To change the point mapping simply select a new binary status point number for a status 
point definition in the blue column. The point number allows the Interface Module to find 
the point data in the polled response from the external device.

Active State

Select the active state that is returned from the external device for the associated status 
point number. For example, if close and open are the same point number, and the external 
device reports close as a “1,” then the close active state is “1” and the open state is active 
“0.” If close and open are different point numbers, then the active state is “1” for both. 

Polled Status

When “Running” is selected from the “Begin Setup” screen, the returned binary status will 
be displayed for the programmed points.

 Table 1 contains a list of the status point requirements for IntelliTEAM. Note that not 
all points will be available in all external devices. The lack of some features in the various 
supported external devices will need to be taken into account with the UIM logic. 

External Device Status 
Points Map
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Status Point Name Description

Close State � True if the switch mechanism is in the closed position

Open State � True if the switch mechanism is in the open position

Lockout Status � True if the relay has tripped to lockout

Normal Profile z True if the normal profile is active

Alternate Profile 1 z True if alternate profile 1 is active

Alternate Profile 2 z True if alternate profile 2 is active

Alternate Profile 3 z True if alternate profile 3 is active

Alternate Profile 4 z True if alternate profile 4 is active

Alternate Profile 5 z True if alternate profile 5 is active

Grd Trip Blocked True if the relay is indicating that trip on ground current is blocked

Grd Trip Enabled True if the relay is indicating that trip on ground current is enabled

Reclosing Blocked z True if the relay is indicating that reclosing is blocked

Reclosing Enabled z True if the relay is indicating that reclosing is enabled

Remote Mode Enabled � True if the relay is indicating that remote mode is enabled

Trouble Status1 True if the relay is reporting that trouble is active

Trouble Status2 True if the relay is reporting that trouble is active

Hot Line Tag z True if the relay has hot line tag active

Freq. Trip Target z True if the relay has tripped due to frequency anomaly

Trouble Status3 True if the relay is reporting that trouble is active

Phase A Fault � True if the relay is indicating an A phase fault has been detected

Phase B Fault � True if the relay is indicating a B phase fault has been detected

Phase C Fault � True if the relay is indicating a C phase fault has been detected

Neutral Fault � True if the relay is indicating a neutral or ground fault has been detected

Phase A Volt Present True if the relay is indicating voltage is detected on phase A

Phase B Volt Present True if the relay is indicating voltage is detected on phase B

Phase C Volt Present True if the relay is indicating voltage is detected on phase C

Trouble Status4 True if the relay is reporting that trouble is active

Recloser Cycle Status z True if the relay is fault cycling

Recloser Reset Status z True if fault cycling has ended and the switch is closed

� Required DNP Point.

z Required DNP Point if supported by the external device.

� The Remote Mode Enabled point should be mapped. If not mapped or configured

 N/A it will always be displayed as Active.

Table 1. Status Point requirements for IntelliTEAM.

Universal Interface Module Setup

NOTICE
If the switch open/close status is reported as both open and closed, a ten second 
timer starts. If the status is still the same when the timer expires, the team enters the 
stop transfer state, and both a log event message and status change are reported.
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6.     Click the External Device Menu Button, then the Analog In Points Button, 
and enter the correct values for the External Device.

This screen allows programming of the analog input points used by the Interface Module 
and IntelliTEAM. The minimum required points are highlighted with an asterisk. Additional 
points will need to be mapped depending upon the desired protection settings.

Point Number

To change the point mapping simply select a new analog input point number for an analog 
point defined in the blue column. The point number allows the Interface Module to find 
the point data in the polled response from the external device.

Scaling Factor

Normally phase current is expected in units of one amp per count.  This parameter may 
be used to set a scaling factor if necessary to adjust the reported value to the one amp per 
count expected scaling.  The scaling factor and the line kV base ratio are used to convert 
the external devices reported phase voltage data to a 120 vac base. The displayed value 
will be compared to the voltage loss threshold in Setup: Automatic Operation for extended 
phase or 3 phase voltage losses. The scaling factor for the 3-phase currents and the 3-phase 
voltages can be set from 0.01 to 100.

Polled Data

With a scaling factor of “1,” the polled data is the actual analog data reported by the external 
device for that programmed point number.

Line kV to 120 vac Base Ratio

As described above, enter a value to get a 120 vac base displayed for the 3 phase volt-
ages.

 The scaling factors here do not modify what will be reported when a SCADA master 
polls for analog input data, there are separate scaling factors for SCADA DNP.

Figure 6. SETUP: DNP Analog Input Points Map for the External Device.

External Device Analog 
Input Points Map
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Figure 7. SETUP: DNP Control Points Map for the external device.

7.     Click the External Device Menu Button, then the Control Points Button, and 
enter the correct values for External Device.

This screen contains control point mapping specifically for those points required for use 
by IntelliTEAM. The Interface Module must know what point numbers are associated with 
the given control functionality so that IntelliTEAM can operate properly. The minimum 
required control points are marked with an asterisk. Others will be required depending 
on the desired protection settings.

Point Number

To change the point mapping simply select a new control point number for a control 
point defined in the blue column. This point number is the one that the external device 
recognizes for the defined name.

Object Type

Select from the six types that the external device supports for the associated control 
point. 

Function

DNP Direct Operate is the only function type supported for control points that are con-
trolled by the Universal Interface Module or IntelliTEAM. 

Test

Clicking on the “Activate Point” will send the control point as it is programmed to the 
external device. This facilitates quick verification for control point operation and reported 
binary statuses.

External Device Control 
Points Map

Ç WARNING
Selecting Activate Point will cause an operation of the external device.  Be sure all 
standard safety precautions are followed prior to testing points.

Universal Interface Module Setup
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 Reset Fault Targets

 To give IntelliTEAM the most accurate information, fault targets need to be cleared in the 
external device when fault cycling is done and a good closed indication is present. If the 
external device is in a switch mode and/or logic is not available to reset targets, entering 
this control point and setting the timer below will cause the UIM to initiate the resetting 
of fault targets.

 Fault Targets Timeout (seconds)

 This timer is used to wait the programmed amount of seconds before the UIM sends the 
reset fault targets DNP control point to the external device.

 Last Control Point Number

The Interface Module doesn’t poll for the binary output status from the external device 
(to get a count of how many control points the external device supports). So when it is 
time to program control points to be used by SCADA (Comm Menu, Control Point Map), 
enter the highest index number (that the external device supports) for the control points 
that you want to make available for mapping.

 Control Point Operation Timeout (seconds)

This value is used by IntelliTEAM as the upper limit on how long it takes for control point 
operation. Successful operation time is based upon the polling rate, and the returned 
binary status associated with the control point.

 Control Relay Pulse On/Off Time (ms)

 The on and off times in the control relay output block can be programmed from 0-99999999 
ms.

Control Point Name Description

Normal Profile z Command to enable the normal settings profile of the host control device

Alternate Profile 1 z Command to enable the alternate settings profile 1 of the host control 
device

Alternate Profile 2 z Command to enable the alternate settings profile 2 of the host control 
device

Alternate Profile 3 z Command to enable the alternate settings profile 3 of the host control 
device

Alternate Profile 4 z Command to enable the alternate settings profile 4 of the host control 
device

Alternate Profile 5 z Command to enable the alternate settings profile 5 of the host control 
device

Trip � Command to open the contacts of the breaker or recloser

Close � Command to close the contacts of the breaker or recloser

Ground Trip Blocked Ground Trip for use by the Universal Interface Module and IntelliTEAM is 
not supported at this time

Ground Trip Enabled Ground Trip for use by the Universal Interface Module and IntelliTEAM is 
not supported at this time

Reclosing Blocked z Command to block the reclosing feature of the host control device

Reclosing Enabled z Command to unblock the reclosing feature of the host control device

Reset Fault Targets � Command to clear the fault targets in the host control device

� Required DNP Point.

z Required DNP Point if supported by the external device.

� Not required if host device automatically clears fault status when it closes.

Table 2. Control Point requirements for IntelliTEAM.
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Figure 8. SETUP: Communications for the external device.

8.     Click the External Device Menu Button, then the E.D. Comm Button, and 
enter the correct values for External Device.

This screen contains communications-related setpoints specifically related to communica-
tions with the external device. 

Module-to-External Dev. DNP Port

Enter the serial port that is connected to the external device, port A, B, C, or Ethernet. 

External Device IP Address

Enter the IP address of the External Device when Ethernet is used for the connection.

Module-to-External Dev. Polling Interval (.1 seconds) 

The Interface Module polls the external relay/switch device for data and stores that data 
in an internal database. This parameter defines the rate, in seconds, that this polling will 
take place.  

Module-to-External Dev. Polling Timeout (.1 seconds) 

This is the amount of time (automatically calculated) the Interface Module waits before 
logging a communication timeout. For the normal data polls, when timeouts occur, the 
pending message is deleted off the transmit list and another poll is sent. Set the above 
polling interval and then go to External Device Menu, Begin Setup, set the Extended Poll-
ing Log Messages to Enabled and then go to Data Logging, Historic Events, Logging Level 
All and verify that “Data Poll Sent to Ext. Device” and “Data Received from Device” are 
logged without timeouts being logged. When done, set the Extended Polling Log Messages 
to Disabled, so the compact flash doesn’t fill up with these messages.

 External Device RTU Address 

This is the DNP RTU address that is configured in the external relay/switch device directly 
connected to this Interface Module. As is normally the case, this RTU address must be 
unique within the communications system. 

External Device 
Communications Setup

Universal Interface Module Setup
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Binary Input Variation 

This is the DNP object variation used in the Interface Module’s poll to the external device 
for binary input data.  Using a variation of “1” specifically requests “Single Bit Binary 
Input” data.  Using a variation of “0” allows the external device to select the variation of 
the binary input data it will respond with.

 Selecting variation “2” Binary Input with Status will cause the UIM to look at the offline 
status of every binary input returned by the external device. If any offline statuses are 
found, an alarm condition is entered and any IntelliTEAM activity will be stopped.

Binary Input Qualifier 

This is the DNP qualifier code used in the Interface Module’s poll to the external device 
for binary input data.  Using a qualifier of “6” requests that all available binary input data 
objects be returned in the external device response. 

 IMPORTANT: The Interface Module only supports 216 binary status points.

Poll For Binary Input Change With Time 

When the external devices are set to do fast fault cycling and the polling interval is set to 
do slow polling, it’s possible to miss valuable information that occurs in between the poll-
ing interval. Setting this setpoint to “Yes” causes the Interface Module to poll for Binary 
change events. When the events are received, any fault currents or voltage loss events that 
are active are reported to IntelliTEAM.

 NOTE:  If there are too many events stored in the external device (events haven’t been 
polled for in a long time) the time it takes to receive them all might exceed the poll timeout 
value resulting in Reset Link being sent to the external device instead of the confirmation 
acknowledgement. This causes the events to not be purged from the external device and 
the process to repeat. So purge old events from the external device first and then enable 
this setpoint. The transmit and receive LEDs for the port connected to the external device 
should show 1 transmit indication followed by 1 receive indication. 

Analog Input Variation 

This is the DNP object variation of analog input data that will be requested.  Using a 
variation of “2” specifically requests “16-bit Analog Input” data from the external device.  
Using a variation of “0” allows the external device to select the variation of analog input 
data it will respond with. 

 NOTE:  The Interface Module supports only 16 bit analog values.  If the default variation 
of  “0” is used be sure the external device is configured to return 16 bit analog values. 

Analog Input Qualifier 

This is the DNP qualifier code for analog input data that will be requested.  Using a quali-
fier of “6” requests that all available analog input data objects be returned in the external 
device response. 

 IMPORTANT: The Interface Module only supports 126 analog input points.

NOTICE
IntelliLINK Remote Users:  Changing the RTU Address, or other communication 
parameters, can stop this device from communicating with IntelliLINK Remote and 
its other team members. IntelliTEAM stops working when it can’t reach a team mem-
ber. If you do loose communication with a control, you must go to the site, connect 
directly to that control, and reset the RTU Address, or other changed communication 
parameter.
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Binary Counter Variation 

This is the DNP object variation of binary counter data that will be requested.  Using a 
variation of “0” allows the external device to select the variation of binary counter data 
it will respond with. 

 NOTE:  The Interface Module supports up to 32 bit counters.

Binary Counter Qualifier 

This is the DNP qualifier code for binary counter data that will be requested.  Using a 
qualifier of “6” requests that all available binary counter data objects be returned in the 
external device response. 

 IMPORTANT: The Interface Module only supports 16 binary counters.

Analog Output Data Size

When DNP receives a request to set one of the 16 mapped Analog Outputs that will be sent 
to the external device, this setpoint is used to match the data size supported.

Total Binary Status, Analog Input and Counter Points 

To help verify the Interface Module is receiving data from the external device, these real 
time counts are the totals received. If 38 binary status points are displayed, with a zero 
reference, the device is returning 0 - 37. 

 NOTE:  The Interface Module sends three DNP objects to the external device: Binary 
Status, Analog Inputs and Binary Counters. For correct operation the external device can 
to respond to all three or can return data for just Binary Status and Analog Inputs.

Universal Interface Module Setup
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Figure 9. SETUP: Remote Prohibit Restoration Transmit List.

9.     Click the External Device Menu Button, then the E.D. Comm Button, and 
select Pg Dn.

This screen contains setpoints specifically related to sending the Prohibit Restoration 
SCADA command to remote devices. Each non-zero RTU address in this list will receive a 
latch on, direct operate SCADA control point when any of the following events are active in 
the local UIM Control: Hot Line Tag is active, a Frequency Trip has occurred, IntelliTEAM 
has determined that a manual operation has occurred or (when Enable Remote Transmit 
from Local P.R. is enabled) and Prohibit Restoration is active at the local UIM from the 
front panel, SCADA or the screen set. 

RTU Address

Enter the address of the remote device.

DNP Port

Select which port to use for transmitting to the remote device.

IP Address 

If Ethernet is selected above, enter the IP address here.

Retry Count 

Enter the number of retries to perform on timeouts.

Retry Time 

Enter the amount of time in seconds to wait before retries are attempted.

Control PT# 

Enter the control point number that activates Prohibit Restoration in the remote device.

Enable Remote Transmit from Local P.R. 

When this setpoint is enabled, and Prohibit Restoration (P.R.) is active at the local UIM 
from the screen set, front panel or SCADA, all devices with non-zero RTU addresses will 
have the programmed control point transmitted to them.

Remote Prohibit 
Restoration Transmit 
List

Universal Interface Module Setup
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Figure 10. SETUP: Communications - General, Page 1.

10. On the PRESENT CONDITIONS screen click the Comm Menu button for the 
SETUP: Communications - General (Page 1 of 5) screen (Figure 10). Enter 
the correct values for the Universal Interface Module.

This screen contains setpoints related to IntelliTEAM and SCADA (if applicable) com-
munications. This screen includes the following fields:

UIM DNP Address

Enter the network address for this Universal Interface Module installation. This must be 
the same as the “DNP/RTU Address” (on the SETUP: Team screen) for this team member. 
Be sure to enter an address even if this interface module will not be accessed via SCADA. 
RTU address must be greater than 0 and less than 65520.

Master Station RTU Address

This is the master station RTU address to which the Universal Interface Module sends all 
unsolicited responses. Leaving this address at zero prevents the Interface Module from 
generating any unsolicited responses, whether or not the “Unsolicited Responses to Master 
Station” has been enabled.

Master IP Address (if applicable)

This is the IP Address that must be used to route DNP frames to the master station over 
a UDP connection. This parameter only applies to IP based SCADA networks.

Communications Setup

Universal Interface Module Setup

NOTICE
IntelliLINK Remote Users:  Changing the RTU Address, or other communication 
parameters, can stop this device from communicating with IntelliLINK Remote and 
its other team members. IntelliTEAM stops working when it can’t reach a team mem-
ber. If you do loose communication with a control, you must go to the site, connect 
directly to that control, and reset the RTU Address, or other changed communication 
parameter.
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Master Station Port Code

This is the local serial port through which DNP frames destined for the master station 
must be sent. This may be set to any serial port configured for DNP communications. This 
parameter only applies to serial based SCADA networks.

Number of Retries for Confirm

If the first transmit of a message that contains event data, whether unsolicited or requested, 
does not result in a confirmation message within the time delay (see “Time Delay Between 
Retries” below) the message may be resent. This parameter defines the number of times 
the control will resend the message before stopping and saving the event data. Setting 
this parameter to zero will prevent the retry process and result in only a single attempt to 
send the message to the master.

Time Delay Between Retries (seconds)

If the control did not receive a confirmation message within this time period, it retransmits 
the response with a request for another confirmation (unless the “Number of Retries for 
Confirm” has been reached).

Unsolicited Response Mode

When this parameter is enabled the control sends a message to the SCADA master station 
when new event data is available based on the “Unsolicited Transmit Delay Event Count” 
and “Unsolicited Transmit Delay Time” below. If this feature is enabled, you must also 
enter a master station RTU address on this screen (see “Master Station RTU Address”) 
and a port code or IP address through which to reach the master station.

 Enabling this feature may add significant communication traffic to your communica-
tion network.

Unsolicited Transmit Delay Event Count

This is the number of new events that will cause an unsolicited message to be transmit-
ted, provided the “Unsolicited Transmit Delay Time” has not been reached first. If this 
parameter is set to one an unsolicited message will be sent immediately upon the first 
new event generated.

Unsolicited Transmit Delay Time (seconds)

This is the maximum delay in seconds that may elapse after the first new event before 
which an unsolicited message is transmitted to the master station. During this delay other 
new events may be added to the unsolicited message. If the number of events reaches the 
“Unsolicited Transmit Delay Event Count” before this delay time expires the unsolicited 
message will be transmitted immediately.

Ç WARNING
If you move an already-configured UIM to a new location, be sure to enter the NEW 
address into the UIM. If you leave the old address in the UIM, it may respond to 
instructions meant for a different switch location.
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Unsolicited Retried Indefinitely

As required by DNP, this parameter allows the configuration of unsolicited message retries 
to be performed for an indefinite period of time. S&C recommends that this parameter 
remains disabled for normal operation.

Time Sync Request Interval (minutes)

Although the Interface Module maintains the time and date in a highly accurate battery-
backed clock chip, you can force the control to request a time synchronization message, 
from the DNP Master Station, by enabling this setpoint. If you set an interval, the Interface 
Module requests the time upon startup, and then again every interval, on the interval.

Output Block Point Select Timeout (seconds)

This is the timeout duration of the Select function on control points. (For details about 
using analog outputs, see the DNP Points List and Implementation.) If the timeout duration 
is too short between the Select and the Operate functions during a Select-Before-
Operate sequence, the Interface Module disables the point and reports a timeout to the 
master station.

Usage of “Self” Address 65532

This parameter allows the special DNP “Self” address (RTU address 65532) to be enabled 
and disabled. The use of this address can be very helpful during initial configuration of 
the control over a local DNP link (this is the only way to communicate over DNP to the 
control when the local RTU address has not yet been configured), or when the local RTU 
address is not known.

 Use of the DNP “Self” address should be restricted to local communications only. This 
address should not be used over a network connection.

Limit Unknown Master Functionality

When this parameter is enabled it prevents a master/peer station that is not included in 
the configuration of this control from writing to or controlling this control. Master/peer 
stations configured in this control include the “Master Station RTU Address,” the “Mainte-
nance Master RTU Address” (see below), and team members that are explicitly configured 
in the Team setup screens.

 This parameter is disabled by default to allow master station addresses to be entered 
into the configuration. Once entered this parameter may be enabled as long as a configured 
master station address is being used to complete the rest of the configuration process.

Maintenance Master RTU Address

This is a secondary master station address that may be configured to allow local access 
to this control for the purpose of configuration changes and diagnostics. This master RTU 
address allows the same access to the control that the main master station address allows, 
except that unsolicited messages will only be sent to the main master station address.

 The Maintenance Master RTU Address should not be used to request event data from 
the control. Requesting event data using this address will prevent the main master station 
from receiving this same event data.

Use Verbose Diagnostic DNP Logging

If you are diagnosing a communications issue you can set this parameter to Enabled to 
have messages logged for every frame that is transmitted and received. The additional 
messages are:

• Frame accepted by DL (data reported is Source Address, Destination Address, Transport 
Header, Frame Length)

• AL accepted good fragment (data reported is Source address, Data Length, Application 
Control, Function Code)

• App layer accepted FIR-FIN message (data reported is Transport Header, Fragment 
Length, Source Address)

Universal Interface Module Setup
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 Leaving this feature enabled for an extended period will cause historic logs to fill more 
quickly and reduce the amount of saved historical events.

Solicited Response Event Confirmations

When this parameter is enabled an Application Layer Confirmation will be requested with 
every solicited response that includes event data. When disabled a confirmation will not 
be requested for solicited responses that include event data. Normally this parameter 
should be set to Enabled so that event data is not discarded until the master station has 
acknowledged receiving it. If in the disabled mode the operation is not considered to be 
DNP 3.0 compliant.

 This parameter has no affect on Unsolicited Report by Exception responses.

Use DNP3 Compliant Startup

DNP3 Compliant Startup requires that the master station acknowledge an initial empty 
unsolicited message, and then send a SCADA command to enable unsolicited reporting. 
If acknowledgment of the initial empty unsolicited message is not received the UIM con-
tinues to resend these messages at the configured retry interval until an acknowledgment 
is received. Setting this parameter to Disabled makes use of a non-standard mode that 
bypasses the initial empty unsolicited messages, and the requirement for the master sta-
tion to enable unsolicited reporting with a SCADA command, and simply starts sending 
unsolicited responses as events occur, provided that the Unsolicited Responses parameter 
is enabled. 

 NOTE: This parameter affects a change only during startup. If you must disable this 
parameter in order to be compatible with your master station then you should also restart 
the UIM so that the change takes affect.
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Figure 11. SETUP: Communications - Serial Ports, Page 2.

11. From SETUP: Communications - General click the PgDn Button to go to 
Page 2 of 5 (Figure 11). Enter the correct values for the Interface Module.

Serial Port Setup

This screen contains setpoints related to IntelliTEAM and SCADA (if applicable) com-
munications. This screen includes the following fields:

Communication Protocol 

This is the protocol to be used on this port. You may set this to either “DNP” (Distributed 
Network Protocol, generally used over a wide area network) or “ICP” (Internal Control 
Protocol, generally used for local IntelliLINK access). You may also set this to “None” if 
you do not plan to use this port for communications.

Communication Baud Rate 

This is the baud rate between the control and the directly-connected communications 
device (radio, modem, etc.). This baud rate must be identical to the baud rate for the 
device. 

RTS Active Before/After Xmit Duration 

This is the amount of time (in milliseconds) that RTS (“request to send”) is active for this 
port before/after a transmission takes place. You can usually leave this at the factory-
default value. 

Inter-Packet Transmit Delay (ms) 

This is the minimum amount of time (in milliseconds) between individual message frames 
transmitted out the serial port. Set this parameter appropriately if your communications 
device requires an inter-packet delay in order to process individual frames of a data 
stream.

Universal Interface Module Setup



  S&C Instruction Sheet 1043-530  33

Universal Interface Module Setup

Figure 12. SETUP: Communications - Ethernet, Page 3.

12. From SETUP: Communications - Serial Ports click the PgDn Button to go to 
Page 3 of 5 (Figure 12). Enter the correct values for the Interface Module.

This screen contains IP address information for the two Ethernet ports available on the 
board. The ports are designated “Native” (or on-chip) and “Add-On” (or off-chip). The 
following IP address information is applicable to both ports, and given valid IP address 
configuration: either port, or both ports, may be used.

IP Address 

This  is the IP address used to uniquely identify and communicate with this device through 
the applicable Ethernet port.

Network Address 

This is the IP network address associated with the applicable Ethernet port. To communi-
cate properly the network address must be the same for all devices that are on the same 
network, and the IP address of the device must be an address within that network. The rela-
tionship between the IP address and the network address is defined by the Netmask. 

Netmask 

This is the netmask associated with the applicable Ethernet port. A netmask is a 32-bit 
mask used to divide an IP address into subnets and specify the networks available hosts. 
In a netmask, two bits are always automatically assigned. For example, in 255.255.255.0, 
“0” is the assigned network address; and in 255.255.255.255, “255” is the assigned broadcast 
address. The 0 and 255 are always assigned and cannot be used.

Broadcast Address 

This is the broadcast IP address associated with the applicable Ethernet port. The broad-
cast address is used to distribute a signal across a network, commonly used to declare to 
other devices on a network that a new device has connected to the network and to give 
those other devices information about the newly connected device. The broadcast address 
on a network is commonly an address that ends with “255.”

Ethernet Setup
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Figure 13. SETUP: Communications - Routing, Page 4.

13. From SETUP: Communications - Ethernet click the PgDn Button to go to 
Page 4 of 5 (Figure 13). Enter the correct values for the Interface Module.

This screen contains routing information for up to 32 destination devices. If a frame is 
received with a destination address other than the local address, this routing information 
will allow that frame to be redirected out an adjacent port. If the destination address is 
not found in the routing table, and a default pass-through route has not been configured 
(see SETUP: Communications-Routing, page 4), then the frame will be dropped. 

RTU Address 

These are the destination DNP RTU addresses that will be searched to find an active route 
when an incoming message frame (not destined for the local device) is received. 

IP Address 

This parameter should be configured if the intended destination device may be found on an 
IP network. This will cause the received frame to be transmitted out the local UDP port. 

Port 

This parameter should be configured if the intended destination device may be found 
through a serial communications port. This will cause the received frame to be transmit-
ted out the configured local serial port. 

Routing Setup

Default Gateway IP 

This is the default gateway IP address that will be used with an IP packet’s destination 
address belongs to someplace outside the local subnet. The default gateway will direct 
the packet out to the external subnet.

Universal Interface Module Setup
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Figure 14. SETUP: Communications - Routing, Page 5.

14. From SETUP: Communications - Routing click the PgDn Button to go to 
Page 5 of 5 (Figure 14). Enter the correct values for the Interface Module.

This screen contains entries that define default routing for messages that are addressed 
to devices which were not found in the configured routing table, and are not the local 
device. This default routing performs a simple pass-through functionality between the 
two interface points. If you do not want unknown traffic to be routed through this device, 
leave these entries unconfigured. 

IP Address 

This parameter should be configured if the intended destination device may be found on an 
IP network. This will cause the received frame to be transmitted out the local UDP port. 

Port 

This parameter should be configured if the intended destination device may be found 
through a serial communications port. This will cause the received frame to be transmit-
ted out the configured local serial port. 
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Figure 15. SETUP: Status Points Map for the Universal Interface Module.

15. From the PRESENT CONDITIONS screen select the Comm Menu button, 
and select the Status Point Map button to display the SETUP: Status Points 
Map (Figure 15). Enter the correct values for the Interface Module.

This screen contains configuration parameters for Status Point mapping allowing you 
to assign internal binary data to any SCADA point number. Doing so will make internal 
binary data accessible via SCADA. 

SCADA Point 

This column displays the point number as it will be seen by your SCADA system in response 
to static or event data requests, or in unsolicited event responses. 

Code 

This column contains internal point codes, representing specific internal binary data, which 
you may select and assign to individual SCADA point numbers. Setting this parameter to 
“End” defines the end of the configured points list and the maximum number of status 
points that can be returned. 

 All internal binary points that can be mapped to individual SCADA points are also dis-
played on the Data Logging/Status Points screens. See S&C Instruction Sheet 1043-550, 
page 65 for the complete list of supported points and their internal numeric codes, which 
are listed in the Code column.

 Binary points received from the external device may also be mapped to individual 
SCADA points. Enter the external device binary point number (limited to a range of 0 to 
255) in this column next to the SCADA point number you would like your master station 
to receive it as. See documentation for the external device for definitions of binary points 
originated from that device.

Class 

This column contains the DNP event class in which this point can be placed. You may 
associate each point with “Class 1,” “Class 2,” or “Class 3” data, or event data reporting 
can be turned off for this point by selecting “No Event.” 

UIM Status Points Map

Universal Interface Module Setup
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Figure 16. SETUP: Analog Input Points Map for the Universal Interface Module.

16. From the PRESENT CONDITIONS screen select the Comm Menu button, 
and select the Analog Input Map button to display the SETUP: Analog Input 
Points Map (Figure 16). Enter the correct values for the Interface Module.

This screen contains configuration parameters for Analog Input Point mapping allowing 
you to assign internal analog input data to any SCADA point number. 

SCADA Point 

This column displays the point number as it will be seen by your SCADA system in response 
to static or event data requests, or in unsolicited event responses. 

Point Code 

This column contains point codes, representing specific analog input data, which you may 
select and assign to individual SCADA point numbers. Setting this parameter to “End” 
defines the end of the configured points list and the maximum number of analog input 
points that can be returned. 

 Analog points received from the external device may be mapped to each individual 
SCADA point. Enter the external device analog point number (limited to a range of 0 to 
255) in this column next to the SCADA point number you would like your master station 
to receive it as. See documentation for the external device for definitions of analog points 
originated from that device.

Evt Class 

This column contains the DNP event class in which this point can be placed. You may 
associate each point with “Class 1,” “Class 2,” or “Class 3” data, or event data reporting 
can be turned off for this point by selecting “No Event.” 

Scaling 

This column allows you to assign a scale factor to the internal data to match analog require-
ments within your SCADA system. 

UIM Analog Input Points 
Map
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% DeadBand 

This column defines a deadband range based on a percentage of the previously reported 
analog event data. If the analog data associated with this point exceeds this range in either 
a positive or negative direction it will be included in the next event report. Set this param-
eter to N/A to prevent deadband event reporting based on percentage. 

Fixed DeadBand 

This column defines a deadband range based on a fixed value relative to the previously 
reported analog event data. If the analog data associated with this point exceeds this range 
in either a positive or negative direction it will be included in the next event report. Set 
this parameter to N/A to prevent deadband event reporting based on a fixed value. 

Figure 17. SETUP: Counter Points Map for the Universal Interface Module.

17. From the PRESENT CONDITIONS screen select the Comm Menu button, 
and select the Counter Point Map button to display the SETUP: Counter 
Points Map (Figure 17). Enter the correct values for the Interface Module.

This screen contains configuration parameters for Counter Point mapping allowing you 
to assign internal counter data to any SCADA point number. Doing so will make internal 
counter data accessible via SCADA. 

SCADA Point 

This column displays the point number as it will be seen by your SCADA system in response 
to static or event data requests, or in unsolicited event responses. 

Point Code 

This column contains internal point codes, representing specific counter data, which you 
may select and assign to individual SCADA point numbers. Setting this parameter to “End” 
defines the end of the configured points list and the maximum number of counter points 
that can be returned. 

UIM Counter Points Map
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 All internal counter points that can be mapped to individual SCADA points are also 
displayed on the Data Logging/Special Events screens. See the table in S&C Instruction 

Sheet 1043-550, page 69 for the complete list of supported points and their internal numeric 
codes to be supplied in this column.

 Counter points received from the external device may also be mapped to individual 
SCADA points. Enter the external device counter point number (limited to a range of 0 to 
255) in this column next to the SCADA point number you would like your master station 
to receive it as. See documentation for the external device for definitions of counter points 
originated from that device.

Evt Class 

This column contains the DNP event class in which this point can be placed. You may 
associate each point with “Class 1,” “Class 2,” or “Class 3” data, or event data reporting 
can be turned off for this point by selecting “No Event.” 

% DeadBand 

This column defines a deadband range based on a percentage of the previously reported 
counter event data. If the counter data associated with this point exceeds this range in 
either a positive or negative direction it will be included in the next event report. Set this 
parameter to N/A to prevent deadband event reporting based on percentage. 

Fixed DeadBand 

This column defines a deadband range based on a fixed value relative to the previously 
reported counter event data. If the counter data associated with this point exceeds this 
range in either a positive or negative direction it will be included in the next event report. 
Set this parameter to N/A to prevent deadband event reporting based on a fixed value. 



40  S&C Instruction Sheet 1043-530 

Figure 18. SETUP: Control Points Map for the Universal Interface Module.

18. From the PRESENT CONDITIONS screen select the Comm Menu button, 
and select the Control Point Map button to display the SETUP: Control 
Points Map (Figure 18). Enter the correct values for the Interface Module.

This screen contains configuration parameters for Control Point mapping allowing you 
to assign control outputs to any SCADA point number. 

SCADA Point 

This column displays the point number that will be used by your SCADA system when 
operating control outputs. 

Point Code 

This column contains internal point codes, representing specific control outputs, which 
you may select and assign to individual SCADA point numbers. Setting this parameter to 
“List End” defines the end of the configured control points list. 

 The internal control points that can be mapped to individual SCADA points are:

“Pro Rest”  Enable or disable IntelliTEAM Prohibit Restoration.  See    
Prohibit Restoration for more information.

“UIM LOV”  Enable or disabled the Loss of Voltage sectionalizing provided by the Uni-
versal Interface Module logic. See Setup Automatic Operation for more 
information.

 
“Clr Man Op”  A momentary pulse point used to clear a manual operation indication. This 

signals to IntelliTEAM that it may return to the ready state provided the 
switch contacts are in their normal open or close position.

UIM Control Points Map
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 Control points associated with the external device may also be mapped to individual 
SCADA points. Enter the external device control point number (limited to a range of 0 to 
255) in this column next to the SCADA point number you would like your master station 
to address it as. See documentation for the external device for definitions of control points 
associated with that device.

Object Type 

This column defines the type of control operation that will be issued by the SCADA master. 
If the object type received in a control command does not match this setting the control 
will be aborted. The object types are:

“Breaker” represents a typical trip/close operation

“Latch” represents a latched on/off operation

“Pulse” represents a momentary control output 

 Set this parameter to “N/A” only if this point will not be used. 

Figure 19. SETUP: Analog Output Points Map for the Universal Interface Module.

19. From the PRESENT CONDITIONS screen select the Comm Menu button, 
and select the Analog Output Map button to display the SETUP: Analog 
Output Points Map (Figure 19). Enter the correct values for the Interface 
Module.

This screen contains configuration parameters for Analog Output Point mapping allowing 
you to assign analog outputs to any SCADA point number. 

SCADA Point 

This column displays the point number that will be used by your SCADA system when 
operating analog outputs. 

UIM Analog Output 
Points Map
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Point Code 

This column contains internal point codes, representing specific analog outputs, which 
you may select and assign to individual SCADA point numbers. Setting this parameter to 
“List End” defines the end of the configured analog output points list. 

 The internal analog output points that can be mapped to individual SCADA points are:

“Feeder load”  Real-time feeder loading provided by the SCADA system.  See   
  External Loading for more information. 

“Retry time”  Time between retries of event data by DNP. See Communica-   
  tions Setup for more information. 

“Retry count”  Count of retries of event data by DNP. See Communications    
  Setup for more information. 

“Select time”  Time allowed between Select and Operate commands in DNP.   
  See Communications Setup for more information. 

 Analog output points associated with the external device may also be mapped to indi-
vidual SCADA points. Enter the external device analog output point number (limited to 
a range of 0 to 255) in this column next to the SCADA point number you would like your 
master station to address it as. See documentation for the external device for definitions 
of analog output points associated with that device.

Universal Interface Module Setup
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Figure 20. Team Setup Menu, where you select the team to be configured.

20. From the PRESENT CONDITIONS screen click the Team Menu button, click 
the Setup Menu button, and click the Team Setup button to display the 
Team Setup Menu (Figure 20). Enter the correct values for the Interface 
Module.

 This screen shows a summary of the DNP/RTU addresses for the teams where this con-
trol is a member.

 The setup buttons for Teams 1 through 8 take you to the next screen where general 
team parameters and information for individual team members are entered for the 
selected team number.

Team Setup
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Figure 21. Individual Team Setup Screen for the Universal Interface Module.

21. From the Team Setup Menu screen (the previous screen) click the SETUP: 
Team 1 button (choose the number of the team you wish to configure) to 
display the SETUP: Team screen for the selected team (Figure 21). Enter the 
correct values for the Interface Module.

These screens show a summary of team parameters for each team where the Interface 
Module is a member:

If available, load the CFG file for each team where the Interface Module is a 
member. Otherwise, go to Step 22.

If you have already created a team setpoint CFG file(s) for the team(s) where this Interface 
Module is a member, you can load the setpoints now.

A. Select File > Load Setpoints.

B. In the Load Setpoints dialog box, select the name of the CFG file for the first team 
where this Interface Module is a member. Click OK. (The IntelliLINK software will 
indicate when the file has loaded. Click OK.) You should see the updated address data 
in the summary table.

C. Do one of the following:

· If this Interface Module is part of another team and you have the corresponding 
CFG file, repeat Steps A and B. Then go to Step 28.

· If this Interface Module is part of another team and you DO NOT have a corre-
sponding CFG file, go to Step 28.

· If this Interface Module is not part of another team, go to Step 28.

Universal Interface Module Setup
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22.   Enter the correct values for this Interface Module (as described below).

The SETUP: Team screens let you set the team-related parameters for each of the teams 
where this Interface Module is a member. Using DNP, you can also connect to other teams 
on the communication network.

 IMPORTANT: For any one team, the values on the associated SETUP: Team screen 
must be identical in all team members, excluding the parameter “Comm Port to Use,” 
see below.

 Each screen includes the following fields:

Team ID 

Enter your name for this team (16 character maximum). The name may help identify the 
team to the SCADA master station operator and appears on all reports generated from 
the team members. When you save a team configuration, the name is saved along with 
the other information. It also appears on the LCD.

Team Logic

This setpoint lets you enable or disable IntelliTEAM operations for this team.

Team Setup

This setpoint lets you change the operational status of the team setup as defined on this 
screen. This setpoint will also change to Stopped automatically if the team logic detects 
a change to any of the parameters on this screen. 

 IMPORTANT: If you set this value to Stopped and then back to Running, the IntelliLINK 
software uses the setpoint values on this screen as the presently valid team parameters. 
Until all team members have identical values on this screen, the team will not be ready 
for transfer.

Alternate Source Sequence

You can set the priorities for the different ways the team members can restore a line seg-
ment. If the team cannot use the source switch (see “Normal Sw Func” below) to restore 
the line segment, then the team tries the members listed here. 

 If you do not enter values for these setpoints, or if the selected team members cannot be 
used to restore the line segment, then the team tries the tie switch(es) to find an alternate 
source. If this is not successful, the team tries the load/tie switch(es).

General Team Parameters

These setpoints apply to the team shown on this page of the SETUP: Team screen as a 
whole.

Line Segment Limit

Set this to the maximum number of line segments that this team can pick up. For example, 
Add 1 inhibits any other line segments from being restored through a member after it 
restores its first line segment. To allow the team to pick up as many line segments as 
capacity allows, set this value to N/A.

 NOTE:  Setting this setpoint to a value other than N/A automatically changes the Con-
tract Required setpoint to Yes.

Contract Required

If a line segment cannot handle any overloading at all, set this value to “Yes.” Once team 
members encounter a line segment in a restoration path that requires a contract, they will 
communicate with all subsequent line segments in the direction of the alternate source to 
insure that the alternate source will not be overloaded. (Note that this also slows down 
the reconfiguration process.)

RTN Time (minutes)

Power must be restored to the faulted line segment for this amount of time (in minutes) 
before the Return to Normal process will start. 



46  S&C Instruction Sheet 1043-530 

PR Time (minutes)

Set this value to the length of time you would like to allow this team to attempt to restore 
service after an event has begun. If this timer expires prior to restoration of service the 
team will enter the Prohibit Restoration state, preventing any further restoration activity 
by this team until the Prohibit Restoration state is cleared through the appropriate SCADA 
command, or on the Prohibit Restoration screen  in the Miscellaneous Operation menu, 
or the faceplate button.

Individual Team Member Parameters

These setpoints apply to the individual team members in this team.

DNP/RTU Address 

This column shows the DNP/RTU address for each team member. One of the addresses 
here must be the DNP/RTU address entered on the SETUP: Communications screen.

Comm Port to Use

This column shows the Ethernet or serial port through which this team member may be 
found for the purpose of peer-to-peer communications. If a single radio is being used for 
peer-to-peer communications then set this parameter to the Ethernet or serial port to which 
the radio is connected. Since the port to route through to get to any given team member 
may be different at each member, this is the only parameter on this screen that need not 
be set the same in each member of the same team.

 NOTE: This parameter is not saved in a Team Setpoint Profile and must be modified 
separately if the default value (Port B) is not correct.

Sw/Pos Number

This column shows the switch/position number associated with the team member, for 
example Sw1 for a single overhead switch.

Normal Open/Close 

This column shows the state of each line switch when the circuit is configured normally. 
The team uses this information during transfer operations.

Normal Sw Func

There are six types of functionality for team members: 

Functionality Description

Normally Closed Switches, Breakers or Reclosers 

Source/Sub Use this value when the source switch is the first team 
member after the substation/source, or is an Interface 
Module on the source breaker relay.

Source Use this value for one closed switch in the team through 
which the line segment receives power when the circuit 
is in its normal configuration.

Universal Interface Module Setup
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Functionality Description

Load/Tie A team may have zero, one, or multiple closed switches 
through which loads on other line segments receive power. 
Use this value when the switch could be involved in restor-
ing power to the line segment because line segments on 
the other side of the switch have alternate sources.

Load A team may have zero, one, or multiple closed switches 
through which loads on other line segments receive power. 
Use this value when the switch could not be involved in 
restoring power to the line segment because line seg-
ments on the other side of the switch have no alternate 
sources.

IMPORTANT: Every Closed switch or recloser should 
have its sensors facing the normal source of the team.

Normally Open Switches, Breakers or Reclosers 

Tie/Sub Use this value when the tie switch is the first team member 
after the substation/source.

IMPORTANT: A Tie/Sub switch or recloser should have 
its voltage sensors facing the alternate source..

Tie Use this value for zero, one, or multiple open switches in 
the team that restore power to the line segment directly 
from an alternate source when closed..

Rtn to Norm Mode  

If desired, the team members can return the circuit to its normal configuration either 
automatically once a stable 3-phase voltage has been restored to the faulted line segment, 
or on command. For teams with one or more tie switches, you can choose open transition 
(the tie switch(es) open before the other team members return the circuit to its normal 
configuration) or closed transition (the team members close all of the switches and then 
the tie switch(es) open). The Return to Normal process starts at the line sections closest 
to the normal source, then works outward. 

 If Return to Normal Mode is set to None, all manual operations will result in a team 
error.

 A single team member should have the same Return to Normal mode for each team 
where it is a member; however, a team may end up with members with different modes. 
(For more details, see the Operations chapter.) 

Maximum Capacity

This is the loading capacity that you will allow beyond this line switch. Be sure to take 
into account cable/wire size and any other circuit restrictions. 
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Figure 22. External Source Loading Setup Screen for the Universal Interface Module.

23. From the PRESENT CONDITIONS screen click the Team Menu button, click 
the Setup Menu button, and click the External Loading button to display the 
External Source Loading Setup screen (Figure 22). Enter the correct values 
for the Interface Module.

The SETUP: External Source Loading screen allows the DNP master (e.g., RTU or SCADA), 
that is monitoring feeder loading measured at a breaker, to transmit that loading data to 
the first IntelliTEAM switch on that feeder outside the substation. This loading data will be 
used in conjunction with the following setpoints to calculate a real-time excess capacity 
that will be used when transfers occur. 

 Both of the setpoints, Maximum Source Capacity and Default Source Segment Loading, 
have to be set to enable this feature. 

Maximum Source Capacity (amperes)

Maximum Source Capacity is the maximum feeder capacity as viewed from the substation 
end.  This should be entered as a value representing the maximum three phase load in 
amperes that the feeder can carry at anytime.

Default Source Segment Loading (amperes)

Default Source Segment Loading is the estimated maximum load of the source side seg-
ment between the substation feeder breaker and first automated switch.  This should be 
entered as a value representing the peak three phase load in amperes that would be used 
to estimate the first segment maximum load expected, in the event the real-time feeder 
loading data is not available or valid.  

Real-Time Feeder Loading Valid Timer (minutes)

Whenever the real-time feeder data is received through SCADA, this configurable timer 
will start counting down. If the real-time feeder loading data has not been updated within 
the configured interval (timer counts down to zero), the IntelliTEAM loading calculations 
will default to using the Default Source Segment Loading.

External Source Loading 
Setup
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STATUS: Source Loading Data

If both the Maximum Source Capacity and Default Source Segment Loading setpoints 
have not been configured, then the real-time loading feature will not be active, causing 
this field to show Disabled, even if the team member receives feeder loading data.  The 
present calculations using Maximum Capacity would be used in this case.

STATUS: Real-Time Loading Data

If the DNP analog output value received is zero, or is less than the local real-time load of 
the switch, or is greater or equal to the Maximum Source Capacity setpoint, or has not 
been updated within the timer described above, then this field will show the data as invalid. 
The Default Source Segment Loading would then be used in this case.

STATUS: Excess Capacity - Source

The Excess Capacity - Source is calculated by subtracting the real-time feeder loading data 
(received through DNP) from the new Maximum Source Capacity setpoint. Local Capacity 
will be calculated as it is presently. With real-time feeder loading data, Real Capacity at 
the configured Source switch will then be computed as the lesser of either Local Capac-
ity or Excess Capacity - Source. If the real-time data is invalid, Excess Capacity is then 
calculated as: Maximum Source Capacity minus the Default Source Segment Load minus 
the extended load seen at the switch.
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Peer-to-Peer Message Retry Time (seconds) 

The control waits this amount of time (in seconds) to receive a response from another team 
member. If it does not receive the response within this time period, it sends the message 
to that team member again. It continues sending the message until it receives a response 
or reaches the “Peer-to-Peer Message Retry Count.” 

Peer-to-Peer Message Retry Count 

This is the number of times that the control retries sending a message to a team member 
that does not respond within the “Peer-to-Peer Message Retry Time.” 

NOTE: Decreasing the “Peer-to-Peer Message Retry Time,” or increasing the “Peer-to-Peer 
Message Retry Count,” may have a negative effect on some communications systems due 
to increased traffic. Be sure to take this into account when changing these setpoints.

Team Member Re-qualify Time (minutes) 

This is the number of minutes a team member will remain disqualified as a potential alter-
nate source after that team member attempted, but was unable, to restore full service. This 
inability to restore full service is likely the result of a second contingency event such as 
a loss of phase between the alternate source and the team member attempting to restore 
service. In this case the team member would have closed, found that 3-phase voltage was 
not present, and reopened. The possible values are:

Figure 23. Miscellaneous Setup Screen for the Universal Interface Module.

24. From the PRESENT CONDITIONS screen click the Team Menu button, click 
the Setup Menu button, and click the Misc Setup button to display the 
SETUP: Miscellaneous screen (Figure 23). Enter the correct values for the 
Interface Module.

Miscellaneous Setup

Universal Interface Module Setup
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Disabled

The team member will not be disqualified. If no other team member is found to restore 
service to the line section then this same team member will be tried again. If 3-phase 
voltage is still unavailable the switch will open again, and this cycle will continue 
on a relatively quick interval until another source is found, or good 3-phase voltage 
returns at this team member.

Never 

The team member will be disqualified after the first attempt to restore service and will 
remain disqualified until service is restored from another source.

1 to 254

The team member will be disqualified after the first attempt to restore service, but 
will be re-qualified after this number of minutes. Once re-qualified the team member 
will be allowed to close, once again attempting to restore service.

This screen allows you to map IP addresses to DNP/RTU addresses for team members 
that are accessible only over an Ethernet port. An entry must be included in this table for 
any team member where the “Port to Use” has been set to “IP/Eth.”

DNP Address 

This column contains the DNP/RTU address for the IP based team members. 

IP Address 

This column contains the IP address associated with the destination team members. 

Figure 24. IP Address Mapping Setup Screen for the Universal Interface Module.

25. From the PRESENT CONDITIONS screen click the Team Menu button, click 
the Setup Menu button, and click the IP Map button to display the SETUP: IP 
Address Mapping screen (Figure 24). Enter the correct values for the Inter-
face Module.

IP Address Map
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26. Mark these values as the valid team parameters.

 Set the Team Setup to Stopped, if not set there already (see page 10). Click OK. Then 
set it back to Running and click OK. This lets the IntelliLINK software know that it 
should check the settings of subsequent team members against the values on this 
screen.

27. Do one of the following:

• If this Interface Module is part of more than one team, Page Down to display 
that team’s SETUP: Team screen. Repeat Step 20 and Step 21.

 Once you have entered the correct setpoint values for each team, go to the next 
step.

• If this Interface Module is NOT part of more than one team, go to the next 
step.

28. If necessary, create a team CFG file for each team where this Interface    Module 
is a member.

 You can save the values on the SETUP: Team screen for each team where this Interface 
Module is a member. You can then load this file at subsequent members of this team 
to insure that all team members have the same setup.

 A. Select File > Save Setpoints. Select the desired Setpoint Profile, then click OK.

B. In the Save Setpoints dialog box, choose a name and location for the file                    
(for example, “team1234567”). The extension “.CFG” is added automatically.

 C. If this Interface Module is part of another team, repeat Steps A and B.

 See the Saving and Loading a Setup Configuration in S&C Instruction Sheet 1043-540 

for more details.

29. Do one of the following:

• If this Interface Module is NOT the last member of this team, go to Step 30.

 Once you have entered the correct setpoint values for each team, go to the next 
step.

• If this Interface Module IS the last member of this team, go to Enable Normal 
Team Operation, Step 33.

30. If desired, save a snapshot or generate a report.

 Save a snapshot if you want a record of the team settings or if you have a problem that 
requires help from S&C. For details, see Using Snapshots in S&C Instruction Sheet 

1043-540.

31. Exit the IntelliLINK software.

 Select File > Exit, then click OK to exit the IntelliLINK software.

32. Disconnect your computer from the Interface Module.

Universal Interface Module Setup
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Enable Normal Team 
Operation

After all team members have been set up, you then check the team(s) for normal               
operation. 

1. On the Interface Module faceplate, set PROHIBIT RESTORATION ON/OFF for 
desired operation.

 For normal team operation, set the faceplate switch to OFF.

2. If desired, review the present status of the local Interface Module and the 
team(s).

 A. Click the Operation button to display the OPERATION MENU screen. 

 B. Do either of the following:

• For information about the local host device, click the Control Device    

Operation button. 

• For information about the team(s), click the Team Operation button.  
Confirm that “READY” appears in the “Ready Status” field for all teams. This 
indicates that the team is ready to take action (even if a transfer event has 
already taken place) and that there are no errors, faults, battery problems, or 
team communication problems present. For more details about a particular 
team, click its OPER button.

For a detailed explanation of the LOCAL OPERATION and TEAM OPERATION screens, 
see the View the Local Operation Screen and View the Team Operation Screens in 
S&C Instruction Sheet 1043-550.

3. If desired, save a snapshot.

 Save a snapshot if you want a record of the team settings or if you have a problem that 
requires help from S&C. For details, see Using Snapshots in S&C Instruction Sheet 

1043-540.

 NOTE:  Unless you have high speed communications links, we recommend that you 
save a snapshot only from the locally-connected Universal Interface Module.

4. Exit the IntelliLINK software.

 Click File > Exit. Then click OK in the dialog box to exit the IntelliLINK software.

5. Shut down your computer, and disconnect it from the Interface Module.

This completes the Universal Interface Module Setup Instructions.

Go to S&C Instruction Sheet 1043-540.

33. On the Interface Module faceplate, set the PROHIBIT RESTORATION ON/OFF 
switch to the preferred position.

 It is safest to set PROHIBIT RESTORATION to ON – to avoid unexpected operation 
of the switch while you set up the rest of the team. If you don’t have a SCADA system, 
you will have to physically return to each Interface Module and select the PROHIBIT 
RESTORATION OFF position before you can complete your team setup and test the 
system. With a SCADA system, a command can be issued to each Interface Module 
to PROHIBIT RESTORATION OFF.

34. Go to the next installation site.

 Install the Interface Module hardware. See S&C Instruction Sheet 1043-510, then set 
up the software using IntelliLINK software, as described above.







Pr
in

te
d 

in
 U

.S
.A

.


